## Contents

<table>
<thead>
<tr>
<th>About CentreVu Network Reporting</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is CentreVu Network Reporting?</td>
</tr>
<tr>
<td>Available reports</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CentreVu Network Reporting Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required hardware and software</td>
</tr>
<tr>
<td>Security</td>
</tr>
</tbody>
</table>

### Install and Uninstall CentreVu Network Reporting Software

- Install CentreVu Network Reporting
- Uninstall CentreVu Network Reporting

### Basic Window Features

- Data Collector
  - Opening Saved Reports
  - Connect to CMS Server Window
  - CentreVu Network Reporting Connection Window
- Data Reporter
  - Data Reporter Window
- File Menu
- View Menu
- Help Menu
- Report Popup Menu
  - CentreVu Supervisor Popup Menu
- Split/Skill Report Window
- VDN Report Window
- Drill-Down Report Window

### Report Administration

- Report Administration Windows
- Options Window
- Threshold Administration Window
- Customize Data Header Window
- Custom Calculation Manager Window

### Report Administration Features

- Hiding and Restoring Columns
- Setting Directional Indicators
- Administering Thresholds
- Customizing Column Headers
### Adding and Removing Custom Calculation Columns

### Sorting Within Reports

### Creating Sub-Groups

### Deleting Sub-Groups

### Save As HTML

### Saving a Report Layout

### Hardware and Software Related Capacities

### Capacities

### Split/Skill Reports

- Split/Skill Report Description
- Generating and Viewing a Split/Skill Report
- Generating Split/Skill Reports in CentreVu Network Reporting
- Generating a Drill-Down Graphical Report in CentreVu Network Reporting

### VDN Reports

- VDN Report Description
- Generating and Viewing a VDN Report
- Generating VDN Reports in CentreVu Network Reporting
- Generating a Drill-Down Graphical Report in CentreVu Network Reporting

### Using the Drill-Down Feature

- Drill-Down Report Description
- Generating Drill-Down Reports

---

**Copyright © 2000**

**Lucent Technologies.**

All rights reserved.

Modified: September 5, 2000
About CentreVu Network Reporting

Purpose

About CentreVu Network Reporting provides an introduction to the product, its features and an overview on the reports available in CentreVu Network Reporting.

Audience

This section is intended for anyone interested in an overview of the reports available in CentreVu Network Reporting.

Contents

This section includes the following topics:

- What is CentreVu Network Reporting?
- Available reports

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
What is CentreVu Network Reporting?

Introduction

CentreVu Network Reporting is a multi-site real-time and historical reporting application. CentreVu Network Reporting allows you to request the call center data from your ACDs and view CentreVu CMS real-time and historical data through CentreVu Network Reporting's built in viewer.

CentreVu Network Reporting provides a high level view of your call center operations for multiple call centers at the same time and provides consolidated real-time and historical reports on split/skill and VDN statistics. In addition, you can adjust and customize the reports to best meet your business needs using CentreVu Network Reportings' built in features.

Copyright © 2000
Lucent Technologies. All rights reserved.
Modified: September 5, 2000
Available reports

Overview

CentreVu Network Reporting provides two different multi-site reports and a drill-down feature, through which you can view your call center operations. The information here describes each of the reports and the drill-down feature.

Contents

The following multi-site reports are described:

- Split/Skill reports
- VDN reports
- Drill-Down feature

Split/Skill reports

From this report, you can view CentreVu CMS real-time or historical split/skill data. CentreVu Network Reporting also provides a variety of features which allow you to customize the data that is contained in the report to best meet your business needs.

In order to view specific details on a split/skill report, you are required to enter the following information when connecting to a CMS server:

- CMS Server name or IP address
- Server version number
- Real-Time or Historical report mode
- Desired Split/Skills per ACDs

For more information about the Split/Skill report, see Split/Skill Reports.

VDN reports

From this report, you can view CentreVu CMS real-time or historical VDN data. CentreVu Network Reporting also provides a variety of features which allow you to customize the data that is contained in the report to best meet your business needs.

In order to view specific details on a VDN report, you are required to enter the following
information when connecting to a CMS server:

- CMS Server name or IP address
- Server version number
- Real-Time or Historical report mode
- Desired VDNs per ACDs

For more information about the VDN report, see [VDN Reports](#).

**Drill-Down feature**

While viewing a report, you can drill-down on a single data item. The drill-down report will graphically display the current values of the selected data in either a pie chart or a bar chart.

You can only view one drill-down report at a time. For more information about the drill-down feature, see [Using the Drill-Down Feature](#).
Purpose

CentreVu Network Reporting Requirements explains the hardware and software requirements that must be met before CentreVu Network Reporting can run properly.

Audience

This section is intended for anyone who plans to install or use CentreVu Network Reporting. This includes Lucent Technologies' Technical Support organizations.

Contents

This section includes the following topics:

- [Required hardware and software](#)
- [Security](#)

References

The following documentation contains information relevant to the connectivity and interaction of CentreVu Network Reporting.

- [Lucent Call Center Release 8 Documentation CD-ROM 585-210-926](#)
- [CentreVu CMS Administration 585-210–910](#)
- [CentreVu CMS Custom Reports 585-215-822](#)
- [CentreVu Supervisor Installation and Getting Started 585-210–928](#)
- [CentreVu Supervisor Reports 585-210–929](#)
Required hardware and software

Requirements

The following requirements must be met, in order to run CentreVu Network Reporting properly:

- Pentium II processor running at 233 MHz or faster
- 64 megabytes of RAM
- SVGA monitor and graphics card supporting 256 colors, with a minimum resolution of 800x600
- 100 megabytes of free disk space
- Ethernet communications board
- CD-ROM drive
- CentreVu CMS Version 6.0 or later
- A Network connection (network stack must be Winsock 2.0 or later)

In addition to the above hardware, you need one of the following operating systems:

- Microsoft Windows 98
- Microsoft Windows NT 4.0
  - If you are running Windows NT 4.0, you will need to install Service Pack 4 or later. The Windows NT 4.0 Service Pack 4 is available at the Microsoft web site of http://www.microsoft.com/
- Microsoft Windows 2000
Security

Permissions

CentreVu Network Reporting uses the same permission structure as CentreVu CMS. Each user has permissions which provide different levels of access to the CMS system, including read and write permissions for all features purchased and ACDs.
Install and Uninstall CentreVu Network Reporting Software

Purpose

Install and Uninstall CentreVu Network Reporting Software describes the procedures for installing and uninstalling the CentreVu Network Reporting software.

Contents

This section includes the following topics:

- Install CentreVu Network Reporting
- Uninstall CentreVu Network Reporting

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Install CentreVu Network Reporting

Before you begin

The information contained in the installation instructions describes only those procedures that require you to input information or make choices.

If you are running Windows NT 4.0, you will need to install Service Pack 4 or later. If you do not have Service Pack 4, setup will abort and ask you to install Service Pack 4. The Windows NT 4.0 Service Pack 4 is available at the Microsoft web site of http://www.microsoft.com/.

If you will be installing the CentreVu Network Reporting application to a server, you can initially copy the contents of the entire CentreVu Network Reporting CD-ROM to a shared folder on the file server and then follow the installation instructions for each client PC.

CentreVu Network Reporting is copyrighted and requires the appropriate licenses for each client PC it is installed on.

Important!

You will need to be logged in using a login ID with Administrator privileges.

To install CentreVu Network Reporting:

1. Insert the CentreVu Network Reporting CD-ROM into your PC's CD-ROM drive.
   This step can be bypassed if you are installing CentreVu Network Reporting from a server.

2. From the start menu choose Run... From the Run window, select browse, and choose setup.exe from the CD-ROM drive or from the server's shared CentreVu Network Reporting's directory if you are installing from a server.

3. | If the system crashed during a previous install | then Follow the instructions on the screen for a crash cleanup.
   | Result: Setup will clean up the crash and bring you to the Welcome window. |
setup proceeds as normal.

**Result:**

The Welcome window appears.

4. At the Welcome window, select Next > to continue with setup.

**Result:**

The Select Help and Guided Tour Files window displays.
5. At the Select Help and Guided Tour Files window, select Next > to continue with setup if you only want to install the On-Line Help and Guided Tour in English.

If you want to install an additional language file of the On-Line Help and Guided Tour, select the language file from the list of languages available and select Next >.

**Result:**

Setup installs English and any optionally selected language files of the Help and Guided Tour Files.

Setup then checks for adequate disk space.

6. **If**

   * setup finds adequate disk space on your PC,

   **then**

   the Choose Destination Location Window appears.
Result:
Select Next > and go to step 6.

If setup does not find adequate disk space, you are prompted to either select a different installation location or to exit setup and free up additional disk space on the selected drive, then return to step 1.

7. Select the destination folder on your PC that you want CentreVu Network Reporting to be installed to, or click Next > to accept the default.

Result:
The Select Program Folder window appears.
8. Select the program folder on your PC that you want CentreVu Network Reporting installed to, or click Next > to accept the default.

Result:

The Check Setup Information window appears.
9. Select Next > to continue with setup, or select < Back to change the setup information.

**Result:**

Setup installs CentreVu Network Reporting to your computer.

10. | If | then |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>all setup tasks were successfully completed,</td>
<td>you will be asked if you want to view the README file.</td>
</tr>
</tbody>
</table>

**Result:**

Setup is finished.
setup was unable to overwrite an active file,
you will be asked to reboot your computer.

**Result:**
You need to reboot your PC before you use *CentreVu* Network Reporting.
Setup Complete

Setup has finished copying files to your computer.

Before you can use the program, you must restart Windows or your computer.

- Yes, I want to restart my computer now.
- No, I will restart my computer later.

Remove any disks from their drives, and then click Finish to complete setup.
Uninstall CentreVu Network Reporting

To uninstall CentreVu Network Reporting:

1. On your PC desktop, select Start.
2. Select Control Panel from the Settings menu.
3. From the Control Panel, select Add/Remove Programs.
4. Select CentreVu Network Reporting V9 (default name), and then select the Add/Remove button.

Result:

The uninstall procedure removes CentreVu Network Reporting from your PC.

![Remove Programs From Your Computer](http://prodpubs.lucent.com/final/centrevu/CVNR_V9_HTML_Masters/v9_user/howtouninstall.htm)
Basic Window Features

Purpose

Basic Window Features describes the windows found in CentreVu Network Reporting.

Audience

This information is intended for anyone using CentreVu Network Reporting.

Background Information

CentreVu Network Reporting consists of two parts that collect and report data.

The Data Collector is the part of CentreVu Network Reporting that makes queries against the selected CentreVu CMS servers.

The Data Reporter is the part of CentreVu Network Reporting that displays the data gathered by the Data Collector. You can access the Data Reporter by first connecting to a CentreVu CMS server and selecting real-time or historical split/skill or VDN items through the Data Collector.

Contents

This section includes the following topics:

- Data Collector
- Data Reporter
Data Collector

Purpose

The Data Collector section provides a description of the various windows utilized from the Data Collector tool.

Contents

This section contains information on the following windows:

- Opening Saved Reports
- Connect to CMS Server Window
- CentreVu Network Reporting Connection Window

Copyright © 2000 Lucent Technologies. All rights reserved.
Modified: September 5, 2000
Opening Saved Reports

Description

If the user has previously saved report layouts, the following window displays each time CentreVu Network Reporting is executed:

Options

To view a report that contains previously defined settings (data mode, connected servers, data filters, display settings and groupings) highlight the report to view and select OK.

The Other button gives you the option of using a file browser to navigate Explorer or Network folders to locate CentreVu Network Reporting report layouts that were saved to a directory other than the system default directory of C:\Program Files\Lucent\CentreVu Network Reporting V9\Reports..

If you wish to manually input report parameters, select Cancel which returns you to the Connect to CMS Server window where manual entries can be input.
**Connect to CMS Server Window**

**Description**

If no report layout files have been previously saved, the Connect to CMS Server window is automatically launched when you initially start the Data Collector. You can connect to a maximum of sixteen (16) CentreVu CMS servers and eight (8) ACDs per CMS in one session.

![Connect to CMS Server Window](image-url)
## Options

The following options are available in the Connect to CMS Server window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Enter the name of the CentreVu CMS server you wish to connect to in this field. Any names previously typed in this field are stored and available in the drop-down box.</td>
</tr>
<tr>
<td>Remove button</td>
<td>A previously entered server name and filter history can be removed from the systems history by selecting the server name from the drop-down list and selecting this button.</td>
</tr>
<tr>
<td>Server Version</td>
<td>Select the Server Version number from the drop down box for the CMS server you are attempting to connect to.</td>
</tr>
<tr>
<td>Connected Servers</td>
<td>This box provides a list of the CentreVu CMS server CentreVu Network Reporting is currently connected to.</td>
</tr>
<tr>
<td>Real-Time or Historical</td>
<td>Select whether you want the selected data to be displayed in a real-time or historical report.</td>
</tr>
</tbody>
</table>

When Historical is selected, an applicable entry for each of the following input fields is required:

- **Date**: enter a historical date relevant to the selection in the Interval field.

- **Time**: enter a historical time or time range relevant to the selection in the Interval field.

  For example: 08:00 AM-05:00 PM for an hourly Interval.

- **Interval**: select hourly, daily, weekly or monthly from the drop down box.
| **Split/Skill(s) Data Filter** | For each ACD, enter the desired Split/Skill(s) to view report data. Use the following parameters in the entry field, to set your desired split/skill data values:

- To specify more than one Split/Skill, use a semicolon as a separator.
- To specify a range, use a dash between Split/Skills
- No data will be available if a box is left blank for an ACD.

When the server is launched, all filters are saved for that server. Subsequently, when a server is selected from the drop-down box the last filters entered for that server are automatically populated. Pressing CTRL+ E will clear all of the filter fields. |
|---|---|
| **VDN Data Filter** | For each ACD, enter the desired VDN(s) to view report data. Use the following parameters in the entry field, to set your desired VDN data values:

- To specify more than one VDN, use a semicolon as a separator.
- To specify a range, use a dash between VDNs
- To specify all VDNs, use an asterisk.
- No data will be available if a box is left blank for an ACD.

When the server is launched, all filters are saved for that server. When a server is selected from the drop-down box, the last filters entered for that server are automatically populated. Pressing CTRL+ E will clear all of the filter fields. |
| **Connect button** | Clicking this button will start the connection with the server specified in the Server Name field. Once a server name in the Connected Servers listbox is selected, the current filter information for that server will be displayed and the Connect button changes from Connect to Update. |
| **Update button** | If a server name in the Connected Servers listbox is selected, the current filter information for that server will be displayed. The Connect button will change to read Update. By modifying the Split/Skill or VDN settings and clicking Update, the filters for that server will change when you are returned to the Report View. |
| **View Report** | After connecting to the desired server(s), clicking this button will launch the [Data Reporter](http://prodpubs.lucent.com/final/centrevu/CVNR_V9_HTML_Masters/v9_user/connectcmsserver.htm) |
Help button Clicking this button will launch the online help.
CentreVu Network Reporting Connection Window

Overview

From this window, you manually login to the CentreVu CMS Server, by using a valid CentreVu CMS username and password. The username and password are the same as the ones used for your CentreVu CMS. Please see your system administrator if you need help with your username and password.

At the input terminal type field, enter cvsup.

Description

When you click on the Connect button in the Connect to CMS Server Window, the Manual Login window appears. When you have successfully connected, the window automatically minimizes.
Data Reporter

Purpose

This section describes the windows that make up the Data Reporter feature of CentreVu Network Reporting.

Contents

This section contains the following information:

- **Data Reporter Window**
- **File Menu**
- **View Menu**
- **Help Menu**
- **Report Popup Menu**
- **CentreVu Supervisor Popup Menu**
- **Split/Skill Report Window**
- **VDN Report Window**
- **Drill-Down Report Window**

Copyright © 2000

Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Data Reporter Window

Overview

The Data Reporter Window is CentreVu Network Reporting's built-in report viewer. The window looks different based on the report you are currently viewing. This window has some features that are common for all reports.

Window

The following window example is taken from a real-time split/skill report.

![Real-Time Split/Skill Report Example]

Window Description

The Data Reporter window has a general look and feel for all reports. The report itself is located in the center of the window.

The legend for the connection status on real-time reports is located in the lower left corner of the window. The legend for high or low critical warnings for real-time and historical reports is also located in the lower left corner.

The real-time report window lists the status of the connected server and the corresponding ACDs within the report. An up-arrow represents a connected status, where an arrow with a line through it represents an unconnected status.

The selected Servers, ACDs, Split/Skills or VDNs are located in the grey section to the left of the data columns for all reports.

The following menu options are available For each report type:

- File menu
- View menu
Basic Window Features

- Help menu
- Report Popup menu
- CentreVu Supervisor Popup menu

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
## File Menu

### Description

The File menu is available from the split/skill, VDN and drill-down reports. This menu allows you to return to the Report Layout Selector window, save a report layout, save a report as HTML, return to the Connect to CMS Server window or to exit the reporting window.

![File Menu](image)

### Options

The following are options in the File menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Report</td>
<td>Selecting this option takes you to the Report Layout Selector window.</td>
</tr>
<tr>
<td></td>
<td>Previously saved reports can be selected to view from the Report Layout</td>
</tr>
<tr>
<td></td>
<td>Selector window.</td>
</tr>
<tr>
<td>Save Report</td>
<td>Selecting this option saves the current report settings (data mode,</td>
</tr>
<tr>
<td></td>
<td>connected servers, data filters, display settings and groupings) as a file</td>
</tr>
<tr>
<td></td>
<td>to a default directory on your hard drive.</td>
</tr>
<tr>
<td></td>
<td>Subsequently, this report will be available for selection from the Report</td>
</tr>
<tr>
<td></td>
<td>Layout Selector window.</td>
</tr>
<tr>
<td>Save As HTML</td>
<td>Selecting this option saves the current report as an HTML file to a default</td>
</tr>
<tr>
<td></td>
<td>directory on your hard drive.</td>
</tr>
<tr>
<td></td>
<td>Once a report is saved as HTML, a copy of it can be printed from your</td>
</tr>
<tr>
<td></td>
<td>HTML browser.</td>
</tr>
<tr>
<td>Data Collection</td>
<td>Selecting this option returns you to the Connect to CMS Server window. New servers can be added or changes can be made to current settings.</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exit</td>
<td>Selecting this option terminates the reporting application. Upon exiting, you may be prompted to save the current settings as a report before the application closes.</td>
</tr>
</tbody>
</table>

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
View Menu

Description

The View menu is available from the split/skill, VDN and drill-down reports. This menu allows you to change between split/skill and VDN data; launch the Adding and Removing Custom Calculation Columns; launch the Options Window; or launch the Threshold Administration Window.

Options

The following are options in the View menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split/Skill</td>
<td>Selecting this option changes the report display to split/skill data. Split/Skill is the default selection when the application starts. This option is not available in the drill-down report.</td>
</tr>
<tr>
<td>VDN</td>
<td>Selecting this option changes the report display to VDN data. This option is not available in the drill-down report.</td>
</tr>
<tr>
<td>Options...</td>
<td>Selecting this option launches the Options Dialog Window. The Options menu allows you to alter the refresh rate on real-time reports, and hide or show data columns.</td>
</tr>
</tbody>
</table>
Custom Calculations... Selecting this option launches the Custom Calculation Manager. The Custom Calculations window allows custom calculation data columns to be added or removed. Information on managing custom calculations can be found in the Adding and Removing Custom Calculation Columns section.

Thresholds... Selecting this option launches the Threshold Administration Window. Information on administering thresholds can be found in the Administering Thresholds section.
Help Menu

Description

The Help menu is available from the split/skill, VDN and drill-down reports. This menu allows you to view the online help; the Guided Tour; Support on the Web; or the CentreVu Network Reporting About screen.

Options

The following are options in the Help menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Selecting this option launches the online help.</td>
</tr>
<tr>
<td>Guided Tour</td>
<td>Selecting this option launches the online Guide Tour.</td>
</tr>
<tr>
<td>The Guided Tour is a tool to learn how to utilize the features in CentreVu Network Reporting and how to customize the objects in the reports to best your meet business needs.</td>
<td></td>
</tr>
<tr>
<td>Support on the Web</td>
<td>Selecting this option launches the user's web browser and points to the Lucent product support web page.</td>
</tr>
<tr>
<td>About</td>
<td>Selecting this option displays CentreVu Network Reporting's About screen.</td>
</tr>
<tr>
<td>Advanced Debugging</td>
<td>This option is used to perform a few simple serviceability tasks. This option is limited to authorized Lucent personnel.</td>
</tr>
</tbody>
</table>
Report Popup Menu

Description

The report popup menu is available by right-clicking a data column in the report display. From this menu you can hide the selected column; set directional indicators; administer thresholds; and customize the selected data column header.

Options

The following are options in the Report Popup menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide “column name”</td>
<td>Selecting this option hides the current column. To show a column, you must use the Options Window from the View menu. This option is not available in the drill-down report.</td>
</tr>
<tr>
<td>Directional Indicators</td>
<td>Selecting this option will turn on the directional indicators for the selected column in real-time reports. Directional indicators are represented by a small arrow pointing up or down, to the left of the selected value. This option is not available in historical or drill-down reports.</td>
</tr>
<tr>
<td>Thresholds...</td>
<td>Selecting this option launches the Threshold Administration Window. The selected data column is automatically selected in the Threshold Administration Window. Descriptions of each threshold setting can be found in the Threshold Administration Window section.</td>
</tr>
<tr>
<td>Customize...</td>
<td>Launches the <a href="#">Customize Data Header Window</a>. The selected column becomes the data header to be renamed. Customizing column headers can make the headers easier for users to interpret or to better meet business needs.</td>
</tr>
</tbody>
</table>
CentreVu Supervisor Popup Menu

Description

The CentreVu Supervisor report popup menu is available while viewing a report by right-clicking a server name in the Server column. From this menu, you can launch a CentreVu Supervisor session. The most recent CentreVu CMS server you connected to from CentreVu Supervisor will be populated in the CMS server field. If you want to connect to a different CMS server, select it from the drop down box.

Option

Launch CentreVu Supervisor is the only option available from this pop-up menu.

CentreVu Network Reporting will attempt to launch a CentreVu Supervisor session. This selection will only be effective if CentreVu Supervisor software is installed.
Split/Skill Report Window

Description

The Split/Skill report window displays a tabular report form for the values of the selected split/skill data items you enter for each split/skill. For detailed information on the Split/Skill Report please see the Split/Skill Reports section.

Sections

The Split/Skill report window is divided into the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Display</td>
<td>This is the main section located in the center of the window. It displays the values of the selected data items. You can adjust the threshold colors, activate directional indicators and customize the column headers. For more information on adjusting and customizing the report see the Report Administration section.</td>
</tr>
<tr>
<td>Legend</td>
<td>This is the bottom section of the window. It displays the current threshold colors for real-time and historical reports and describes the CentreVu CMS server link status indicator icons for real-time reports.</td>
</tr>
</tbody>
</table>

Options

The following options are available in the Split/Skill report window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| Sort | For real-time reports, sorting is allowed by right-clicking the server name or number, Server Link status, ACD name or number, ACD link, or Split/Skill column header.  
Any column in historical reports can be sorted.  
If you repeatedly click a column you can toggle between ascending and descending sorts. By default the report is sorted by Split/Skill or VDN number. |
| Scroll | You can scroll through the data columns to view your data. The Server name, ACD name or number, and Split/Skill or VDN number column are locked into position to help identify the data rows. |
| Drill-Down | You can double-click a single data column to drill-down to a graphical report on that data item.  
For more information on the Drill-Down Report see the [Using the Drill-Down Feature](#) section. |
VDN Report Window

Description

The VDN report window displays a tabular report form for the values of the selected VDN data items originally entered from the Connect to CMS Server window for each VDN. For detailed information on the VDN Report please see the [VDN Reports](#) section.

Sections

The VDN report window is divided into the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Display</td>
<td>This is the main section located in the center of the window. It displays the values of the selected data items. You can adjust the threshold colors, directional indicators and customize the column headers. For more information on adjusting and customizing the report see the <a href="#">Report Administration</a> section.</td>
</tr>
<tr>
<td>Legend</td>
<td>This is the bottom section of the window. It displays the current threshold colors for real-time and historical reports and describes the CentreVu CMS server link status indicator icons for real-time reports.</td>
</tr>
</tbody>
</table>

Options

The following options are available in the VDN report window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>

### Basic Window Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sort</strong></td>
<td>For real-time reports, sorting is allowed by right-clicking the server name or number, Server Link status, ACD name or number, ACD link, or VDN column header. &lt;br&gt;Any column in historical reports can be sorted. &lt;br&gt;If you repeatedly click a column you can toggle between ascending and descending sorts. By default the report is sorted by VDN number.</td>
</tr>
<tr>
<td><strong>Scroll</strong></td>
<td>You can scroll through the data columns to view your data. The Server name, ACD name or number, and VDN number column are locked into position to help identify the data rows.</td>
</tr>
<tr>
<td><strong>Drill-Down</strong></td>
<td>You can double-click a single data column to drill-down to a graphical report on that data item. &lt;br&gt;For more information on the Drill-Down Report see the <a href="#">Using the Drill-Down Feature</a> section.</td>
</tr>
</tbody>
</table>

---

**Copyright © 2000**  
**Lucent Technologies.**  
All rights reserved.  
Modified: September 5, 2000
Drill-Down Report Window

Description

The Drill-Down report window graphically displays the selected column from the Split/Skill or VDN Report as a bar chart. For detailed information on the Drill Down feature please see Using the Drill-Down Feature.

Sections

The Drill-Down report window is divided into the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Display</td>
<td>This is the main section located in the center of the window. It displays the values of the selected data items. You can adjust the threshold colors by using the right-click popup menu. For more information on adjusting the report see the Report Administration Windows section.</td>
</tr>
<tr>
<td>Legend</td>
<td>This is the bottom section of the window. It displays the current threshold colors for real-time and historical reports and describes the CentreVu CMS server link status indicator icons for real-time reports.</td>
</tr>
<tr>
<td>Average Column</td>
<td>If you have drilled-down on a data item that has an average as its summary, the last column displayed will be an Average column for the data item. For more information on data items see the Data Items section of the Split/Skill or VDN reports.</td>
</tr>
<tr>
<td>Return To Table</td>
<td>Clicking this button will return you to the Split/Skill or VDN report.</td>
</tr>
</tbody>
</table>
Report Administration

Purpose

Report Administration describes CentreVu Network Reporting report administration tasks and capacities.

Contents

This section includes the following topics:

- Report Administration Windows
- Report Administration Features
- Hardware and Software Related Capacities

Copyright © 2000 Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Report Administration Windows

Purpose

This section describes the various administration windows available in CentreVu Network Reporting.

Contents

This section contains the following information

- Options Window
- Threshold Administration Window
- Customize Data Header Window
- Custom Calculation Manager Window

Copyright © 2000 Lucent Technologies. All rights reserved.
Modified: September 5, 2000
Options Window

Description

The Options window can be accessed through the View Menu on real-time or historical reports. This window allows you to alter the refresh rate and hide or restore data columns.

Options

The following items are available in the Options window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Column Display</td>
<td>In this field you can choose which data columns to show or hide.</td>
</tr>
<tr>
<td></td>
<td>To hide a shown data column, select the data item and click the right arrow.</td>
</tr>
<tr>
<td></td>
<td>To show a hidden data column, select the data item and click the left arrow.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Refresh Rate (seconds)</td>
<td>You can adjust the rate at which the real-time database is refreshed and when the report display is updated. The minimum refresh rate is 3 seconds, and the maximum refresh rate is 5 minutes. Network traffic may affect your refresh rate.</td>
</tr>
<tr>
<td>OK</td>
<td>Selecting OK saves all the options defined and exits the Options window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Selecting Cancel exits the Options window without changing previously defined settings.</td>
</tr>
<tr>
<td>Help</td>
<td>Launches the online help.</td>
</tr>
</tbody>
</table>
Threshold Administration Window

Description

The Threshold Administration window can be accessed through the View Menu or the Report Popup Menu on real-time or historical reports. This menu allows you to set the color, which will represent each threshold in the main report display.

Options

The following are options in the Threshold Administration window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Item:</td>
<td>From this drop-down list you can select the data item you want to administer.</td>
</tr>
<tr>
<td>Threshold Levels:</td>
<td>For each threshold, High Warning, High Caution, Low Caution, and Low Warning, you can set the threshold to your desired level. When you click OK, the values you entered are checked for consistency. If they fail the consistency check, you are asked to re-enter the values. Descriptions of each threshold setting can be found in Threshold Levels.</td>
</tr>
</tbody>
</table>
Normal (Graph Only): The color button next to this, changes the background color of the graph in the report display.

Color buttons: Clicking on a colored button will allow you to change the color for the selected threshold level through a standard *Windows* Color dialog window.

Enable Checking this box will enable the data item's thresholds.

OK Selecting OK saves all the options defined and exits the Threshold Administration window.

Cancel Selecting Cancel exits the Threshold Administration window without changing previously defined settings.

Help Launches the online help.

### Threshold Settings

For each of the reports, Split/Skill, VDN, and Drill-Down, you can assign four threshold settings. These settings can be administered through the Threshold Administration window. Once you have set your desired thresholds, CentreVu Network Reporting will save these settings across sessions.

**Note:** Not all thresholds require an entry. For example:

- Set Low settings to a negative number, if you want notifications on High thresholds only.
- Set High settings to an unusually high number, if you want notifications on Low thresholds only.

### Threshold Levels

The available threshold levels are as follows:

<table>
<thead>
<tr>
<th>Threshold Setting</th>
<th>Event Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Warning</td>
<td>You will be notified when the following event occurs:</td>
</tr>
<tr>
<td></td>
<td>- The data field's value is greater than or equal to the data item's assigned high warning threshold setting.</td>
</tr>
<tr>
<td>High Caution</td>
<td>You will be notified when the following event occurs:</td>
</tr>
<tr>
<td></td>
<td>- The data field's value is greater than or equal to the data item's assigned high caution threshold setting and less than the data item's assigned high warning threshold setting.</td>
</tr>
<tr>
<td>Low Caution</td>
<td>You will be notified when the following event occurs:</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>■ The data item's value is less than or equal to the data item's assigned low caution threshold setting and greater than the data item's assigned low warning threshold setting.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Low Warning</th>
<th>You will be notified when the following event occurs:</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ The data field's value is less than or equal to the data item's assigned low warning threshold setting.</td>
<td></td>
</tr>
</tbody>
</table>

## Colors

Selecting the color button to the right of each threshold setting will allow you to change that threshold setting's color using a standard *Windows* Color dialog window.

---

**Copyright © 2000**

Lucent Technologies.

All rights reserved.

Modified: September 5, 2000
Customize Data Header Window

Description

The Customize Data Header window can be accessed through the Report Popup Menu on real-time or historical reports. This menu allows you to customize the name of the column header for the selected data item.

Options

The following are options in the Customize Data Header window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Header</td>
<td>In this field you can enter the name you wish to use as the new column header. These headers are maintained separately for Split/Skill and VDN data items.</td>
</tr>
<tr>
<td>Default</td>
<td>Restores the data header name for the selected column back to the system default value.</td>
</tr>
<tr>
<td>OK</td>
<td>Selecting OK saves all the options defined and exits the Customize Data Header window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Selecting Cancel exits the Customize Data Header window without changing previously defined settings.</td>
</tr>
<tr>
<td>Help</td>
<td>Launches the online help.</td>
</tr>
</tbody>
</table>
Custom Calculation Manager Window

Description

The Custom Calculation Manager window can be accessed through the View Menu on real-time or historical reports. This window allows you to manage which of the custom calculations will be included in the CentreVu Network Reporting reports. Only split/skill or VDN custom calculations previously created in CMS or CentreVu Supervisor will be available. Aggregate calculations can not be used in reports. Aggregate calculations are standard or custom calculations that include \texttt{sum} in the calculation name or a custom calculation that requests a sum when queried.

Options

The following are options in the Custom Calculation Manager window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Administration</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CMS Server</th>
<th>From this drop-down list you can select the CMS server currently available.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve</td>
<td>After selecting a CMS server, clicking this button will populate the list of available calculations on that server.</td>
</tr>
<tr>
<td>Available</td>
<td>This box lists the available calculations for the CMS server, once they have been retrieved.</td>
</tr>
<tr>
<td>Add to Report</td>
<td>Once the available calculations are listed, click this button to add one or more calculations to the list of data items in the report view. The calculation(s) will then be displayed in the Report Items field.</td>
</tr>
<tr>
<td>Report Items</td>
<td>This field displays a list of custom calculations currently selected.</td>
</tr>
<tr>
<td>Remove from Report</td>
<td>Select one or more calculations from this list and click this button to remove calculation(s) from the report view.</td>
</tr>
<tr>
<td>Done</td>
<td>Exits the Custom Calculation Manager.</td>
</tr>
<tr>
<td>Help</td>
<td>Launches the online help.</td>
</tr>
</tbody>
</table>
Report Administration Features

Purpose

This section describes the report administration features available in CentreVu Network Reporting, that allow you to adjust or customize reports to better meet your business needs.

The following features are only available while viewing the report in CentreVu Network Reporting.

Contents

The following features are discussed:

- Hiding and Restoring Columns
- Setting Directional Indicators
- Administering Thresholds
- Customizing Column Headers
- Adding and Removing Custom Calculation Columns
- Sorting Within Reports
- Creating Sub-Groups
- Deleting Sub-Groups
- Save As HTML
- Saving a Report Layout
Hiding and Restoring Columns

Overview

This feature allows you to select which data columns are shown and which are hidden on the report. For more information on hiding and restoring columns, see the [Options Window](http://prodpubs.lucent.com/final/centrevu/CVNR_V9_HTML_Masters/v9_user/hidingcolumns.htm) located under the View menu on real-time or historical reports.

How to hide data columns

Hide columns by performing the following steps:

1. Select View from the Report menu, or right click on the data column.
2. Select Options.
3. In the Shown — Data Column Display field, double-click the Data Column you wish to be hidden.

   **Result:**

   The selected Data Column Display item will move from the Shown — Data Column Display field, to the Hidden — Data Column Display field.

   Multiple Data-Columns may be selected using standard Windows operations.
4. Once you have completed your selections, select OK to accept your changes and return to the report.

How to restore data columns

Restore hidden data columns by performing the following steps:

1. Select View from the Report menu.
2. Select Options.
3. In the Hidden — Data Column Display field, double-click the Data Column you wish to restore.

   **Result:**

   The selected Data Column Display item will move from the Hidden — Data Column Display field, to the Shown — Data Column Display field.

   Multiple Data-Columns may be selected using standard Windows operations.
4. Once you have completed your selections, select OK to accept your changes and return to the report.
Setting Directional Indicators

Overview

Directional indicators let you know when a selected data field value on real-time reports is greater than or less than the previous reported value. The directional indicators show the movement of the selected value from the last report refresh. They are represented by a small arrow pointing up or down, on the left of the selected value.

How to Set Directional Indicators

While viewing a real-time report, set Directional Indicators by performing the following steps:

1. Right click on the data column you wish to set a directional indicator on.

2. From the Report Popup Menu select Directional Indicators.

   Result:

   An arrow will appear next to the values in the data column on the report, to indicate that value's movement. These indicators will remain in the report until you deselect them from the Report Popup Menu.

Copyright © 2000 Lucent Technologies. All rights reserved. Modified: September 5, 2000
Administering Thresholds

Overview

Setting report thresholds allows the Data Reporter to notify you when an event occurs that exceeds established high and low threshold settings. For more information on the threshold setting see the Threshold Administration window section. Descriptions of each of the four threshold settings can be found in the Threshold Administration window section.

How to Set Report Thresholds

Assign threshold values by performing the following steps:

1. Access the Thresholds Administration window by either selecting it from the View menu on the Report or right-clicking on the data column you wish to set threshold against.

   Result:

   The Threshold Administration window appears.

2. Select a data item you wish to administer thresholds against from the Data Item drop-down box.

3. Set the desired threshold level in each of the four threshold settings fields.

4. If you wish to customize the threshold warning colors, click the color bar to the right of each threshold setting.

   Result:

   The standard Windows Color dialog window displays, allowing you to change that threshold setting’s color.

5. The Normal (Graph Only) field is used to change the background color of the drill-down graphic reports.

6. Check the Enabled box to enable this data item's threshold settings. You can disable any threshold setting, by un-checking the Enabled box.

    Repeat steps 2 through 5 for each data item you wish to set thresholds for.

7. When you have completed your selections, select OK to accept your changes.
Important!

If the values you entered do not pass the consistency check, you will be prompted to re-enter the values.

Result:

You are returned to the report with the thresholds administered.
Customizing Column Headers

Overview

Column headers can be customized from either the Split/Skill or VDN tabular reports. Customizing the column headers allows you to adapt the text to best suit your business needs.

How to customize column headers

While viewing a report, customize column headers by performing the following steps:

1. Right click on the data column you wish to customize.
2. From the Report Popup Menu select Customize.
3. Enter a new name in the Column Header field.
4. When you have completed your entries, select OK to accept your changes.
   Selecting the Default button restores the column header back to the system default value.
Adding and Removing Custom Calculation Columns

Overview

CentreVu Network Reporting allows you to add or remove custom calculation columns to meet your needs. This feature is supported through the Custom Calculation Manager Window.

Aggregate calculations can not be used in reports. Aggregate calculations are standard or custom calculations that include *sum* in the calculation name or a custom calculation that requests a sum when queried.

How to add or remove custom calculations

To add or remove custom calculation columns:

1. Select View from the Report menu.

2. Select Custom Calculations.

   **Result:**

   The Custom Calculation Manager window displays.

3. Select a CMS server from the drop-down list of currently connect CMS server.

4. Select Retrieve to populate the list of available calculations for that CMS server.

5. Once the available calculations list is displayed, add or remove calculations from the current report by either:

   - Highlighting one or more calculations from the Available box and select Add to Report or,
   - Highlighting one or more calculations from the Report Items box and select Remove from Report.

   **Important!**

   Once the Remove from Report action has been completed and the calculations have been removed, it cannot be undone.

   Repeat steps 1–4 for each CMS server for which you want custom calculation modifications made.
6. Select Done once all calculations have been customized for each CMS server.

**Result:**

The Custom Calculation Manager window closes and the current report updates with each calculation modification made. Custom calculations are displayed at the right-most end of the report. No summary information is calculated for custom calculations.
Sorting Within Reports

Overview

This feature is available for the Split/Skill and VDN reports. The data column is sorted alphabetically ascending, descending and unsorted. Unsorted is based on the translations the CMS server receives from each ACD to which it is connected.

How to sort columns

While viewing a real-time Split/Skill or VDN report, data can be sorted to meet your needs by clicking once on the specified column.

The sorting feature allows you to sort a real-time report display by:

- Server name or number
- Server Link status
- ACD name or number
- ACD link, or
- Split/Skill or VDN column header

Any column in Historical reports can be sorted.
Creating Sub-Groups

Overview

This feature is available for the Split/Skill and VDN reports. Sub-Groups are created to allow similar data rows to be grouped together on a report and to provide sub-group summaries on that subset of data.

How to create a sub-group or add a group member

While viewing a report, you can create a sub-group or add a data row to a sub-group by performing the following steps:

1. Right click within the grayed column of a non-grouped data row (except the Server Name column).

   Result:
   
   The Sub-Group popup menu displays.

2. | If | then |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>you want to create a new sub-group containing the selected data row, and place it at the top of the report display,</td>
<td>Select Add to New Group.</td>
</tr>
<tr>
<td>you want to add the currently selected data row to a previously created sub-group,</td>
<td>Select Add to Group.</td>
</tr>
</tbody>
</table>

   Result:
   
   Sub-Groups are identified as Group within the report.

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Deleting Sub-Groups

Overview

Because of changing business needs, there may be times you need to delete a sub-group or remove a member from an existing sub-group.

How to delete a sub-group or delete a group member

While viewing a report, you can delete a sub-group or remove a sub-group member by performing the following steps:

1. Right click within the grayed column of a sub-grouped data row.

   **Result:**

   The Sub-Group popup menu displays.

2.  

<table>
<thead>
<tr>
<th>If</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>you want to remove an entire sub-group,</td>
<td>Select Delete Group (number)</td>
</tr>
<tr>
<td>you want to remove the currently selected data row from its current sub-group,</td>
<td>Select Remove (row identifier) from Group (number)</td>
</tr>
</tbody>
</table>

**Result:**

Data rows that have been removed from sub-groups will be returned to the ungrouped pool and any remaining sub-groups will be renumbered, if applicable.
Save As HTML

Overview

This feature is available for the Split/Skill, VDN, and Drill-Down reports. This feature allows you to save the report as an HTML file.

How to save a report as an HTML file

To save a report as HTML:

1. Select the type of Split/Skill, VDN, or Drill-Down report you want to save.
2. 

<table>
<thead>
<tr>
<th>If</th>
<th>then</th>
</tr>
</thead>
<tbody>
<tr>
<td>you are saving a Split/Skill or VDN report,</td>
<td>sort the display to your liking.</td>
</tr>
<tr>
<td>you are saving a Drill-Down report,</td>
<td>go to the next step.</td>
</tr>
</tbody>
</table>

3. Select Save as HTML from the [File Menu].

4. Enter a unique name to save your HTML file with, and the location where you want the HTML file saved to.

5. Select Save to accept these values and save the report.

Result:

The report is saved as an HTML file in the desired location.

Once a report has been saved as an HTML file, it can be printed from your Internet browser. For more information on printing from your Internet browser, refer to topics about Printing under your Internet browser's Help menu.
Saving a Report Layout

Overview

This feature is available for the Split/Skill and VDN reports. The Saving a Report Layout feature allows you to save the current report layout, so the next time you want to view the same report it is not necessary to re-enter all of the settings such as the CMS server name, etc. The saved report can simply be selected when [Opening Saved Reports].

How to save a report layout

To save a report layout:

1. Select File from the Report menu.
2. Select Save Report.
   **Result:**
   The Save Report window displays with the default for the Save in folder already selected.
3. In the File name field, enter a unique name to identify the report.
4. Select Save to accept these values and save the report layout.
   **Result:**
   Subsequently, when CentreVu Network Reporting is executed you will have the option to select the saved report from the Select a Report Layout window. All of the report settings (data mode, connected servers, data filters, display settings and groupings) will be used to compile the report when it is saved.

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Hardware and Software Related Capacities

Purpose

This section describes the hardware and software related capacities of CentreVu Network Reporting.
Capacities

Description

The following capacities are available in CentreVu Network Reporting:

- connection to a maximum of sixteen (16) CMS servers simultaneously
- connection to a maximum of eight (8) ACDs for each CMS server simultaneously
- connection to any number of Split/Skills or VDNs per ACD site

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Split/Skill Reports

Purpose

Split/Skill Reports describes the data contained in the Split/Skill reports and how to generate and view various Split/Skill reports.

Contents

This section includes the following topics:

- Split/Skill Report Description
- Generating and Viewing a Split/Skill Report

Copyright © 2000 Lucent Technologies. All rights reserved. Modified: September 5, 2000
Split/Skill Report Description

Purpose

This section describes the data contained in the Split/Skill Reports.

Contents

The following topic is discussed:

- Split/Skill Report Description

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Description

The historical and real-time Split/Skill reports are a tabular representation of the selected Split/Skill data items you selected when you started CentreVu Network Reporting. Historical reports display an average, total or maximum value across all the entered split/skill(s) for selected data items. Real-time reports display an average, total or maximum value across all the entered split/skill(s) for selected data items and update the display at the refresh rate you set from the [Options Window]. Both real-time and historical Split/Skill reports display a summary of the Split/Skill data items at the top of each report.

A historical report which displays *** in a custom calculation data column indicates the interval has been changed since the custom calculation data column was originally created and is no longer relevant.

Once the report has been generated, available features allow you to adjust or customize the report to best meet your business needs. These features include sorting the report display, setting data item thresholds, creating a drill-down report on a single data item, setting directional indicators, hiding columns, customizing column headers, adding custom calculation columns, and creating sub-groups. See the section on [Report Administration Features] for more information on working with any of these features.

Real-Time Data Items

The following is a list of the CMS real-time split/skill data items included in the real-time Split/Skill report:

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Description</th>
<th>Database Item, Calculation or Calculation Name</th>
</tr>
</thead>
</table>

http://prodpubs.lucent.com/final/centrevu/CVNR_V9_HTML_Masters/v9_user/splitskilldescription.htm (1 of 10) [9/13/2000 10:40:00 AM]
<table>
<thead>
<tr>
<th>Metric</th>
<th>Definition</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned Calls</td>
<td>The total number of queued calls for each split/skill that abandoned before an agent answered. This includes calls that are ringing at a voice terminal but does not include direct agent calls. It also includes the number of outbound calls for each split/skill that abandoned at the far end before an agent answered. (For the Generic 2.2 switches with ASAI Gateway Interface feature or the Generic 3 with the ASAI feature only).</td>
<td>ABNCALLS1–10</td>
</tr>
<tr>
<td>ACD Calls</td>
<td>Number of CALLSOFFERED calls that were answered by an agent in the split/skill.</td>
<td>ACDCALLS</td>
</tr>
<tr>
<td>Acceptable Service Level</td>
<td>Number of ACDCALLS answered by an agent within the predefined acceptable service level (SERVICELEVEL), as defined in CentreVu CMS on the Call Center Administration: Split/Skill Call Profile window.</td>
<td>ACCEPTABLE</td>
</tr>
<tr>
<td>Average Abandon Time</td>
<td>The average time a caller waited in the Split/Skill before hanging up.</td>
<td>ABNTIME/ABNCALLS</td>
</tr>
<tr>
<td>Average ACD Time</td>
<td>The average talk time (does not include hold time) is calculated for all ACD calls to this split/skill. This does not include talk time on direct agent calls, but it does include talk time of all outbound ACD calls placed by an adjunct (also called outbound predictive dialing), for the Generic 2.2 switches with ASAI Gateway or the Generic 3 with ASAI only.</td>
<td>ACDTIME/ACDCALLS</td>
</tr>
<tr>
<td>Agents Available</td>
<td>The current number of agents that are available to receive ACD calls in each split/skill.</td>
<td>AVAILABLE</td>
</tr>
<tr>
<td>Agents In Ring</td>
<td>The current number of agents that are available and have ACD calls (including direct agent calls) ringing at their voice terminals but have not yet answered. If the agent places a call or answers an extension call, the agent is shown in the AUX work state, rather than in the ringing state.</td>
<td>AGINRING</td>
</tr>
<tr>
<td>Agents in ACD</td>
<td>The total number of agents that are connected to inbound and outbound ACD calls in each split/skill. This does not include agents on direct agent calls.</td>
<td>ONACD</td>
</tr>
<tr>
<td>Agents In ACW</td>
<td>The number of agents who are in the after call work state for each split/skill. This includes agents on ACWIN and ACWOUT calls and agents in ACW not associated with an ACD call.</td>
<td>INACW</td>
</tr>
<tr>
<td>Metric</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Agents in AUX</td>
<td>The current number of agents who are in the AUX work mode for all splits/skills including agents who are handling AUXIN or AUXOUT calls.</td>
<td></td>
</tr>
<tr>
<td>Agents In Other</td>
<td>The current number of agent positions that are doing other work.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For the Generic 3 and Generic 2.2 switches with EAS, the agent did one of the following activities while in the Auto-In or Manual-In state:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ the agent put any call on hold and performed no further action</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ the agent is on a direct agent call or in ACW for a direct agent call</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ the agent is dialing to place a call or to activate a feature</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ the agent has a ringing personal call, with no other activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For the Generic 2.2 switch, the agent in AUXIN/AUXOUT put a call on hold using the Hold button or switchhook flash and performed no further action.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For the Generic 3 switches without EAS, agents are logged into multiple splits and doing work for a split other than this one.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Agent positions show up as OTHER directly after the link to the switch comes up and directly after the agents log in before the CentreVu CMS is notified of the agent's work state.</td>
<td></td>
</tr>
<tr>
<td>Agents Staffed</td>
<td>The total number of agents that are logged into each split/skill.</td>
<td></td>
</tr>
<tr>
<td>Average Speed Of Answer</td>
<td>The average time calls waited in queue and ringing before an agent answered. This does not include direct agent calls, but it does include outbound ACD calls placed by an adjunct (also called outbound predictive dialing), for the Generic 2.2 switches with ASAI Gateway or DEFINITY ECS Generic 3 with ASAI only.</td>
<td></td>
</tr>
<tr>
<td>Calls Waiting</td>
<td>The number of split or skill ACD calls waiting to be answered. This includes calls that are in queue and ringing at an agent voice terminal. It does not include direct agent calls for the Generic 3 switch.</td>
<td></td>
</tr>
</tbody>
</table>
| Direct Agents On ACD | The current number of POSITIONS that are on direct agent ACD calls. DA_ONACD is a subset of OTHER.  
Note: The total number of agents on split/skill and direct agent ACD calls = ONACD + DA_ONACD.  
Requires a Generic 3 switch with the ASAI or EAS feature for direct agent calling. | DA_ONACD |
|---------------------|---------------------------------------------------------------------------------|----------|
| EWT High            | This heading contains EWT for the skill at high priority.  
EWT is the wait time for the call when it is queued to the split/skill at high priority.  
EWT measures only the time it takes to deliver the call to an agent. It does not include ringing time.  
If CentreVu CMS is connected to a switch previous to the Generic 3 Version 4 switch or if vectoring is not activated, the EWT headings and columns are displayed, but the fields are blank. | EWTHIGH |
| EWT Low             | This heading contains EWT for the skill at low priority.  
EWT is the wait time for the call when it is queued to the split/skill at low priority.  
EWT measures only the time it takes to deliver the call to an agent. It does not include ringing time. If CentreVu CMS is connected to a switch previous to the Generic 3 Version 4 switch or if vectoring is not activated, the EWT headings and columns are displayed, but the fields are blank. | EWTLOW |
| EWT Medium          | This heading contains EWT for the skill at medium priority.  
EWT is the wait time for the call when it is queued to the split/skill at medium priority.  
EWT measures only the time it takes to deliver the call to an agent. It does not include ringing time. If CentreVu CMS is connected to a switch previous to the Generic 3 Version 4 switch or if vectoring is not activated, the EWT headings and columns are displayed, but the fields are blank. | EWTMEDIUM |
<table>
<thead>
<tr>
<th>Data Item</th>
<th>Description</th>
<th>Database Item, Calculation or Calculation Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>EWT Top</td>
<td>This heading contains EWT for the skill at top priority. EWT is the wait time for the call when it is queued to the split/skill at top priority. EWT measures only the time it takes to deliver the call to an agent. It does not include ringing time. If CentreVu CMS is connected to a switch previous to the Generic 3 Version 4 switch or if vectoring is not activated, the EWT headings and columns are displayed, but the fields are blank.</td>
<td>EWTTOP</td>
</tr>
<tr>
<td>Oldest Call Waiting</td>
<td>The length of time (in seconds) the oldest ACD call has waited in queue or ringing (at an agent voice terminal for each split/skill in the report) before being answered. This does not include direct agent calls.</td>
<td>OLDESTCALL</td>
</tr>
<tr>
<td>R1 Agents Available</td>
<td>The number of reserve1 agents who are available to take a call. Requires a DEFINITY ECS R6 or later with EAS.</td>
<td>R1AVAILABLE</td>
</tr>
<tr>
<td>R1 Agents On ACD</td>
<td>The number of reserve1 agents on ACD calls for this skill. Requires a DEFINITY ECS R6 or later with EAS.</td>
<td>R1ONACD</td>
</tr>
<tr>
<td>R2 Agents Available</td>
<td>The number of reserve2 agents who are available to take a call. Requires a DEFINITY ECS R6 or later with EAS.</td>
<td>R2AVAILABLE</td>
</tr>
<tr>
<td>R2 Agents On ACD</td>
<td>The number of reserve2 agents on ACD calls for this skill. Requires a DEFINITY ECS R6 or later with EAS.</td>
<td>R2ONACD</td>
</tr>
<tr>
<td>Service Level</td>
<td>Number of seconds within which calls must be answered/connected in order to be considered acceptable (as defined in CMS on the Call Center Administration: Split/Skill Call Profile window).</td>
<td>SERVICELEVEL</td>
</tr>
</tbody>
</table>

### Historical Data Items

The following is a list of the CMS historical split/skill data items included in the historical Split/Skill report:
<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned Calls</td>
<td>The number of ACD calls to the split/skill that abandoned while either waiting in queue (if this was the first split/skill the call was queued to), or while ringing. This total includes calls with talk time less than the phantom abandoned call timer value, if it is set. This total also includes O_ABNCALLS if you have OCM. The O_ABNCALLS is the number of outbound ACD calls that were abandoned by the far end.</td>
<td>ABNCALLS</td>
</tr>
<tr>
<td>ACD Calls</td>
<td>The number of split/skill ACD calls that were queued to this split/skill and answered by an agent for this split/skill. This total also includes O_ACDCALLS if you have the Outgoing Call Management application of ASAI (OCM). The O_ACDCALLS is the number of ACDCALLS that were placed by an adjunct; this is also referred to as predictive dialing.</td>
<td>ACDCALLS</td>
</tr>
<tr>
<td>Average Abandon Time</td>
<td>The average time the split/skill ACD calls were waiting in queue or ringing before abandoning.</td>
<td>ABNTIME/ABNCALLS</td>
</tr>
<tr>
<td>Average ACD Time</td>
<td>The average time the agents spent talking on ACD calls for this split/skill that completed during the interval. This average includes O_ACDTIME if you have OCM.</td>
<td>ACDTIME/ACDCALLS</td>
</tr>
<tr>
<td>Average ACW Time</td>
<td>The average time the agents spent in after call work associated with ACD calls for this split/skill. This average includes O_ACWTIME if you have OCM.</td>
<td>ACWTIME/ACDCALLS</td>
</tr>
<tr>
<td>Average AUX Time</td>
<td>The average time the agents spent in auxiliary work for this split/skill that completed during the interval.</td>
<td>AUXTIME/ACDCALLS</td>
</tr>
<tr>
<td>Average Speed of Answer</td>
<td>The average time the completed split/skill ACD calls were waiting in queue and ringing before being answered by an agent.</td>
<td>ANSTIME/ACDCALLS</td>
</tr>
<tr>
<td><strong>Extension Out Calls</strong></td>
<td>The number of outbound extension calls made by agents logged into this split/skill. Direct agent ACW out calls are not included. For agents in multiple splits/skills, outbound AUX extension calls are included here if this split/skill is the first one that the agent logged into, unless the agent has an ACD call on hold. In this case, the outbound call is recorded for the split/skill associated with the ACD call.</td>
<td>ACWOUTCALLS+_AUXOUTCALLS</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td><strong>Extension Out Time</strong></td>
<td>The time agents in this split/skill spent talking on outbound extension calls. For agents in multiple splits/skills, time spent on outbound AUX extension calls is included here if this split/skill is the first one that the agent logged into, unless the agent has an ACD call on hold. In this case, the outbound call is recorded for the split/skill associated with the ACD call.</td>
<td>_ACWOUTTIME+_AUXOUTTIME</td>
</tr>
</tbody>
</table>
| **Flow In** | The number of calls that were redirected to this split/skill queue from another queue. The following calls are considered inflows:  
  - for switches without vectoring, calls that intraflow from another split's queue to this split's queue  
  - for Generic 2 switches with vectoring and without EAS, calls that are queued to one split and then successfully queue to this split (either by a queue-to-main split vector step or a check-backup split vector step)  
  - with multiple split/skill queuing (DEFINITY ECS switches with vectoring and Generic 2.2 switches with EAS), calls that queue to this split/skill as a nonprimary split/skill and are either answered by an agent in this split/skill or abandoned from ringing in this split/skill  
  - for DEFINTY ECS/Generic 3 Version 2 and later Generic 3 switches, calls that ring at an | INFLOWCALLS |
agent in this split/skill and then requeue to the same split/skill by the Redirection on No Answer to a Split/Skill feature

When a call leaves a VDN (for example by routing to a VDN) or leaves vector processing (for example by routing to a split/skill), the next split/skill to which the call queues is not credited with an inflow.

For Generic 2.2 with EAS, the following calls are not counted as inflows:

- calls that queue to the zero skill after having been queued to a non-zero skill
- calls that queue to a non-zero skill after having been queued to the zero skill
- calls that queue to another skill group after having been queued to a skill group

<table>
<thead>
<tr>
<th>Flow Out</th>
<th>The number of calls offered to this split/skill that were redirected to another destination.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For switches without vectoring, calls that intraflow or interflow to another destination are counted as outflows.</td>
</tr>
<tr>
<td></td>
<td>For switches with vectoring, an outflow is counted:</td>
</tr>
<tr>
<td></td>
<td>- if the call routes to another VDN</td>
</tr>
<tr>
<td></td>
<td>- if the call routes to a number or digits</td>
</tr>
<tr>
<td></td>
<td>- if the call queues to another split (Generic 2 switches without EAS)</td>
</tr>
</tbody>
</table>
### Split/Skill Reports

The **Data Reporter** displays a summary of the real-time and historical Split/Skill data items at the top of each report. The summary is either an average, total, or maximum value. The type of summary depends on the specific data item. The following table describes the type of summary used for each of the data items and which report the data item appears.

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Summary</th>
<th>Real-time, Historical or Both</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned Calls</td>
<td>Total</td>
<td>Both</td>
</tr>
<tr>
<td>ACD Calls</td>
<td>Total</td>
<td>Both</td>
</tr>
<tr>
<td>Acceptable Service Level</td>
<td>Average</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents Available</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents in Ring</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents in ACD</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents in ACW</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents in AUX</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents in Other</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Agents Staffed</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Average Abandon Time</td>
<td>Average</td>
<td>Both</td>
</tr>
<tr>
<td>Average ACD Time</td>
<td>Average</td>
<td>Both</td>
</tr>
<tr>
<td>Average ACW Time</td>
<td>Average</td>
<td>Historical</td>
</tr>
<tr>
<td>Average AUX Time</td>
<td>Average</td>
<td>Historical</td>
</tr>
<tr>
<td>Average Speed of Answer</td>
<td>Average</td>
<td>Both</td>
</tr>
<tr>
<td>Direct Agents on ACD</td>
<td>Total</td>
<td>Real-time</td>
</tr>
<tr>
<td>Calls Waiting</td>
<td>Total</td>
<td>Real-time</td>
</tr>
</tbody>
</table>

### Data Item Definitions

- **Max Delay**
  - The maximum time that a caller waited in queue and ringing before:
    - being answered
    - abandoning
    - being redirected
    - receiving a busy signal
    - being disconnected.
  - The value shown in the Totals line for this column is the maximum of the Max Delay values shown in the individual intervals.

- **Percent ACD Time**
  - The percentage of staffed time that agents in this split/skill spent on ACD calls and in after call work for this split/skill.
  - \(100\% \cdot \frac{\text{I}_{\text{ACDTIME}} + \text{I}_{\text{ACWTIME}}}{\text{I}_{\text{STAFFTIME}}}\)

- **Percent Answered Calls**
  - The percentage of calls queued to this split/skill that were answered by agents for this split/skill.
  - \(100\% \cdot \frac{\text{ADCALLS}}{\text{CALLSOFFERED}}\)
<table>
<thead>
<tr>
<th></th>
<th>Maximum</th>
<th>Real-time</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>EWT Medium</td>
<td>Maximum</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EWT Low</td>
<td>Maximum</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EWT Top</td>
<td>Maximum</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension Out Calls</td>
<td>Average</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension Out Time</td>
<td>Average</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flow In</td>
<td>Total</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flow Out</td>
<td>Total</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max Delay</td>
<td>Maximum</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oldest Call Waiting</td>
<td>Maximum</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent ACD Calls</td>
<td>Average</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Answered Calls</td>
<td>Average</td>
<td>Historical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R1 Agents Available</td>
<td>Total</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R1 Agents on ACD</td>
<td>Total</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R2 Agents Available</td>
<td>Total</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R2 Agents on ACD</td>
<td>Total</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Level</td>
<td>This data item does not contain a summary line.</td>
<td>Real-time</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Generating and Viewing a Split/Skill Report

Purpose

This section describes how to generate and view various split/skill reports.

Contents

The following topics are discussed:

- Generating Split/Skill Reports in CentreVu Network Reporting
- Generating a Drill-Down Graphical Report in CentreVu Network Reporting

Copyright © 2000 Lucent Technologies. All rights reserved. Modified: September 5, 2000
Generating Split/Skill Reports in CentreVu Network Reporting

Overview

The following information provides instructions on how to:

- open a Split/Skill report in CentreVu Network Reporting, where input parameters are manually entered,
- initially open a Split/Skill report in CentreVu Network Reporting, where the previously defined settings for a report have been saved in a file,
- open a Split/Skill report while viewing a report in CentreVu Network Reporting, where the previously defined settings for a report have been saved in a file.

Opening a manual report

1. Start CentreVu Network Reporting.
2. If report layout files have been saved, the Select a Report Layout window displays. If no reports layout files have been saved, the Connect to CMS Server window displays.
3. If the Select a Report Layout window displays, select Cancel to be returned to the Connect to CMS Server window.
4. Enter the name of the CMS server you wish to connect to in the Server Name field. Any names previously entered in this field are available from the drop down box.
   A previously entered server name and filter history can be removed by selecting the server name from the drop-down list and selecting Remove.
5. Select the Server Version number from the drop-down box for the CMS server you are attempting to connect to.
6. Select Real-Time or Historical data.
   When Historical is selected, an applicable entry for each of the following input fields is required:
Date: enter a historical date relevant to the interval selected

Time: enter a historical time relevant to the interval selected

Interval: select time period, day, week or month from the drop-down box

For more information on report input fields, refer to the Connect to CMS Server Window input parameters.

7. In the Data Filters box enter the Split/Skill(s) for each ACD for which you want a report:

- use a semicolon as a separator when specifying more than one value
- use a dash between values to specify a range

When the server is launched, these filter values will be saved and will be available the next time that same server is selected. Pressing CTRL-E will clear all filter entries.

8. Once all of the data type and data filter entries have been made, select Connect to start the connection with the server specified in the Server Name field.

Result:

The CentreVu Network Reporting Connection Window displays, prompting you to enter a login and password to the CMS server. Use a valid CentreVu Supervisor login ID. At the input terminal type field, enter cvsup.

When you successfully connect to the CMS server, a message on the CentreVu Network Reporting Connection window indicates the Connection to the server is up and the window automatically minimizes on you desktop. The Connected Servers field on the Connect to CMS Server window indicates each of the CMS Servers CentreVu Network Reporting is currently connected to.

Repeat steps 1–5 for each additional CMS Server you wish to connect to.

9. Once the Connected Servers field on the Connect to CMS Server Window indicates each of the desired CMS Servers you are connected to, select the View Report menu item.

Result:

The Connect to CMS Server window automatically closes and the Data Reporter window displays with the selected Split/Skill report and data items.

Opening a saved report

1. Start CentreVu Network Reporting.

2. If

   then
<table>
<thead>
<tr>
<th>report layout files have been saved,</th>
<th>the <strong>Select a Report Layout</strong> window displays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>no reports layout files have been saved,</td>
<td>the <strong>Connect to CMS Server</strong> window displays.</td>
</tr>
</tbody>
</table>

3. If the **Select a Report Layout** window opened, select the saved report you wish to view.

4. Select OK.

   **Result:**

   The CentreVu Network Reporting Connection window displays, prompting you to enter a valid CentreVu Supervisor login and password to each required CMS server. At the input terminal type field, enter cvsup.

   Once you successfully connect to each of the required CMS Servers, the selected report will be displayed.

### Opening a saved report while viewing another report

1. Select File from the Report menu.

2. Select Load Report.

   **Result:**

   The Select a Report Layout window displays.

3. Select the report you wish to view.

4. Select OK.

   **Result:**

   The selected report displays.

   If you are not logged into the CMS server for the selected report, you will be prompted to login to that CMS server.
Generating a Drill-Down Graphical Report in CentreVu Network Reporting

Overview

This information describes how to generate a graphical Drill-Down report for a selected data item from a real-time or historical Split/Skill report. For more information on the Drill-Down report see [Using the Drill-Down Feature] information.

Generating a Drill-Down Report

From the Split/Skill Report do the following:

1. Double-click the desired data column within the report.

   It is possible to drill-down on only one data item at a time.

   **Result:**

   A drill-down report is displayed in the Data Reporter window.

2. Select the Return to Table button if you would like to return to the tabular report.
VDN Reports

Purpose

VDN Reports describes the data contained in the VDN reports and how to generate and view various VDN reports.

Contents

This section includes the following topics:

- VDN Report Description
- Generating and Viewing a VDN Report

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
VDN Report Description

Purpose

This section describes the data contained in the VDN Reports.

Contents

The following topic is discussed:

- VDN Report Description
VDN Report Description

Description

The historical and real-time VDN reports are a tabular representation of the selected VDN data items you selected when you started CentreVu Network Reporting. Historical reports display an average, total or maximum value across all the entered split/skill(s) for selected data items. Real-time reports display an average, total or maximum value across all the entered split/skill(s) for selected data items and update the display at the refresh rate you set from the Options Window. Both real-time and historical VDN reports display a summary of the VDN data items at the top of each report.

Once the report has been generated, available features allow you to adjust or customize the report to best meet your business needs. These features include sorting the report display, setting data item thresholds, creating a drill-down report on a single data item, setting directional indicators, hiding columns, customizing column headers, adding custom calculation columns, and creating sub-groups. See the section on Report Administration Features for more information on working with any of these features.

Real-Time Data Items

The following is a list of the CMS real-time VDN data items included in the real-time VDN report:

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Description</th>
<th>Database Item, Calculation or Calculation Name</th>
</tr>
</thead>
</table>

<p>| <strong>Abandoned Calls</strong> | The number of INCALLS that were abandoned while INPROGRESS for this VDN. This includes split/skill and direct agent ACD calls that abandon from queue or from ringing, calls that abandon from vector processing, calls that abandon after being routed to an extension via the &quot;route to&quot; vector command, and for the Generic 2.1 and Generic 3 (prior to Generic 3 Version 2 load 100) switches, calls that abandoned while listening to a forced disconnect announcement. ABNCALLS includes ACD calls and calls routed to an agent or extension with talk times less than the value of the phantom abandoned call timer. ABNCALLS includes ABNCALLS1 through ABNCALLS10, ABNQUECALLS, ABRINGCALLS, PHANTOMABNS, and SLVLABNS are pegged as ABNCALLS. | ABNCALLS |
| <strong>ACD Calls</strong> | The number of split/skill and direct agent ACD calls that were answered by an agent from &quot;queue to main,&quot; &quot;check backup,&quot; &quot;messaging split/skill,&quot; &quot;route to&quot; split/skill or direct agent, and &quot;adjunct routing&quot; to a split/skill or direct agent. ACDCALLS includes ACDCALLS1–10, ACCEPTABLE, ANSCONNCALLS1–10, BACKUPCALLS, and TRANSFERRED. | ACDCALLS |
| <strong>Acceptable Service Level</strong> | Number of ACDCALLS and CONNECTCALLS that were answered within the predefined acceptable service level (SERVICELEVEL), as defined in CentreVu CMS on the Call Center Administration: VDN Call Profile Setup window. | ACCEPTABLE |
| <strong>Active VDN Calls</strong> | The switch-generated count of the number of active calls in the VDN. This includes only incoming trunk calls directly to the VDN. It does not include internal calls to the VDN, transfers to the VDN, or calls that route to the VDN or redirect from ringing to the VDN after having been through another VDN. Available on the Generic 3 Version 4 and later switches and on the ECS with the vectoring feature. | ACTIVECALLS |
| <strong>Average Abandon Time</strong> | The average time a caller waited in VDN before hanging up. | ABNTIME/ABNCALLS |
| <strong>Average ACD Time</strong> | The average talk time (not including hold time) for all ACD calls (which may include direct agent calls) completed during this interval that were processed by the VDN. | ACDTIME/ACDCALLS |
| <strong>Average Speed Of Answer</strong> | The average speed of answer for split/skill and direct agent ACD calls to the VDN that were completed during the reporting period. | ANSTIME/ACDCALLS |</p>
<table>
<thead>
<tr>
<th>Data Item</th>
<th>Description</th>
<th>Database Item, Calculation or Calculation Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Busy + Disc. Calls</td>
<td>Number of calls offered to the VDN that received a forced busy signal or forced disconnect.</td>
<td>BUSYCALLS + DISCCALLS</td>
</tr>
<tr>
<td>Calls waiting</td>
<td>Number of calls (which may include non-ACD and direct agent calls) to the VDN that are currently being processed by the vector, are in queue, or are ringing at an agent's voice terminal.</td>
<td>INPROGRESS — ATAGENT</td>
</tr>
<tr>
<td>Flow In</td>
<td>Number of calls that were redirected to this VDN via a “route to” VDN. Calls are counted regardless of whether they remained connected to the VDN, were abandoned, or were routed to some other destination.</td>
<td>INFLOWCALLS</td>
</tr>
<tr>
<td>Flow Out</td>
<td>The number of calls to this VDN that were redirected to another VDN or a destination outside the switch by way of a “route to” or “adjunct routing” command (Generic 3 switches only). This does not include calls redirected to another vector by way of a “go to vector” command, because those calls stay in the same VDN.</td>
<td>OUTFLOWCALLS</td>
</tr>
<tr>
<td>Oldest Call Waiting</td>
<td>Length of time the oldest call currently waiting in the VDN has been waiting.</td>
<td>OLDESTCALL</td>
</tr>
<tr>
<td>Service Level</td>
<td>Number of seconds within which calls must be answered/connected in order to be considered acceptable (as defined in CMS on the Call Center Administration: VDN Call Profile Setup window).</td>
<td>SERVICELEVEL</td>
</tr>
</tbody>
</table>

**Historical Data Items**

The following is a list of the CMS historical VDN data items included in the historical VDN report:

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Description</th>
<th>Database Item, Calculation or Calculation Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned Calls</td>
<td>The number of ACD calls to the split/skill that abandoned while either waiting in queue (if this was the first split/skill the call was queued to), or while ringing. This total includes calls with talk time less than the phantom abandoned call timer value, if it is set. This total also includes O_ABNCALLS if you have OCM. The O_ABNCALLS is the number of outbound ACD calls that were abandoned by the far end..</td>
<td>ABNCALLS</td>
</tr>
<tr>
<td>VDN Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ACD Calls</strong></td>
<td>The number of split/skill ACD calls that were queued to this split/skill and answered by an agent for this split/skill. This total also includes <strong>O_ACDCALLS</strong> if you have the Outgoing Call Management application of ASAI (OCM). The <strong>O_ACDCALLS</strong> is the number of ACDCALLS that were placed by an adjunct; this is also referred to as predictive dialing.</td>
<td><strong>ACDCALLS</strong></td>
</tr>
<tr>
<td><strong>Adjunct Routing Attempts</strong></td>
<td>Number of times that, in the specified time period, a VDN (<em>DEFINITY ECS switches only</em>) attempted to request routing from an adjunct. This report item includes unsuccessful adjunct routing attempts, which means the adjunct was not able, within the given amount of time established in the vector, to route the call.</td>
<td><strong>ADJATTEMPTS</strong> sum(ADJATTEMPTS) (for the “Totals” line)</td>
</tr>
<tr>
<td><strong>Adjunct Routing Completions</strong></td>
<td>Number of calls that, in the specified time period, were successfully routed by an adjunct via an “adjunct routing” command in a vector. This report item includes direct agent calls completed via the adjunct.</td>
<td><strong>ADJROUTED</strong> sum(ADJROUTED) (for the “Totals” line)</td>
</tr>
<tr>
<td><strong>Backup ACD Calls</strong></td>
<td>Number of calls that, in the specified time period, were answered by an agent in a backup split/skill (split/skill other than the main split/skill) while carried by the VDN. This report item includes messaging split/skill calls, check backup calls, route to split/skill calls, and direct agent calls.</td>
<td><strong>BACKUPCALLS</strong> sum(BACKUPCALLS) (for the “Totals” line)</td>
</tr>
<tr>
<td><strong>Busy + Disc Calls</strong></td>
<td>Number of calls to the VDN that, during the specified time period, received a forced busy signal or disconnect.</td>
<td><strong>BUSYCALLS+DISCCALLS</strong> sum(BUSY+DISCCALLS) (for the “Totals” line)</td>
</tr>
<tr>
<td><strong>Flow In</strong></td>
<td>Number of calls that, in the specified time period, were redirected to this VDN via a “route to” VDN. Calls are counted regardless of whether they remained connected to the VDN, were abandoned, or were subsequently routed to some other destination.</td>
<td><strong>INFLOWCALLS</strong> sum(INFLOWCALLS) (for the “Totals” line)</td>
</tr>
</tbody>
</table>
Flow Out  The number of calls to this VDN that, in the specified time period, were redirected to another destination via a “route to” VDN or external destination. This does not include calls routed to another vector by way of a “go to vector” command.

In Calls  Number of calls to the VDN that were completed in the specified time period.

Lookahead Interflow Attempts  Number of times that, in the specified time period, the switch attempted to route from this VDN using the Lookahead Interflow feature.

Lookahead Interflow Completions  Number of calls that, in the specified time period, the switch successfully routed from this VDN using the Lookahead Interflow feature.

Network Redirects  Number of calls deflected to the network by BSR. Requires the DEFINITY ECS R6 or later.

VDN Interflow  Number of calls that, in the specified time period, were routed from this VDN to a destination outside the switch. This report item includes Lookahead Interflow calls.

VDN Data Summaries

The Data Reporter displays a summary of the real-time and historical VDN data items at the top of each report. The summary type is either an average, total, or maximum value. The type of summary depends on the specific data item. The following table describes the type of summary used for each of the data items and which report the data item appears.
<table>
<thead>
<tr>
<th>Data Item</th>
<th>Total</th>
<th>Real-time</th>
<th>Both</th>
<th>Historical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls Waiting</td>
<td>Total</td>
<td>Real-time</td>
<td>Both</td>
<td>Historical</td>
</tr>
<tr>
<td>Flow In</td>
<td>Total</td>
<td>Both</td>
<td>Both</td>
<td>Historical</td>
</tr>
<tr>
<td>Flow Out</td>
<td>Total</td>
<td>Both</td>
<td>Both</td>
<td>Historical</td>
</tr>
<tr>
<td>In Calls</td>
<td>Total</td>
<td>Historical</td>
<td>Historical</td>
<td>Historical</td>
</tr>
<tr>
<td>Lookahead Interflow Attempts</td>
<td>Total</td>
<td>Historical</td>
<td>Historical</td>
<td>Historical</td>
</tr>
<tr>
<td>Lookahead Interflow Completions</td>
<td>Total</td>
<td>Historical</td>
<td>Historical</td>
<td>Historical</td>
</tr>
<tr>
<td>Service Level</td>
<td>Total</td>
<td>Real-time</td>
<td>Real-time</td>
<td>Historical</td>
</tr>
</tbody>
</table>

This data item does not contain a summary line.

**Copyright © 2000**

**Lucent Technologies.**

All rights reserved.

Modified: September 5, 2000
Generating and Viewing a VDN Report

Purpose

This section describes how to generate and view various VDN reports.

Contents

The following topics are discussed:

- Generating VDN Reports in CentreVu Network Reporting
- Generating a Drill-Down Graphical Report in CentreVu Network Reporting

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Generating VDN Reports in CentreVu Network Reporting

Overview

The following information provides instructions on how to:

- open a VDN report in CentreVu Network Reporting, where input parameters are manually entered,
- initially open a VDN report in CentreVu Network Reporting, where the previously defined settings for a report have been saved in a file,
- open a VDN report while viewing a report in CentreVu Network Reporting, where the previously defined settings for a report have been saved in a file.

Opening a manual report

1. Start CentreVu Network Reporting.

2. If report layout files have been saved, the Select a Report Layout window displays.
   
   If no reports layout files have been saved, the Connect to CMS Server window displays.

3. If the Select a Report Layout window displays, select Cancel to be returned to the Connect to CMS Server window.

4. Enter the name of the CMS server you wish to connect to in the Server Name field. Any names previously entered in this field are available from the drop down box.

   A previously entered server name and filter history can be removed by selecting the server name from the drop-down list and selecting Remove.

5. Select the Server Version number from the drop-down box for the CMS server you are attempting to connect to.

6. Select Real-Time or Historical data.

   When Historical is selected, an applicable entry for each of the following input fields is required:
Date: enter a historical date relevant to the interval selected.

Time: enter a historical time relevant to the interval selected.

Interval: select time period, day, week or month from the drop-down box.

For more information on report input fields, refer to the Connect to CMS Server Window input parameters.

7. In the Data Filters box enter the VDN(s) for each ACD for which you want a report.
   ■ Use a semicolon as a separator when specifying more than one value.
   ■ Use a dash between values to specify a range.

When the server is launched, these filter values will be saved and will be available the next time that same server is selected. Pressing CTRL-E will clear all filter entries.

8. Once all of the data type and data filter entries have been made, select the Connect button to start the connection with the server specified in the Server Name field.

Result:

The CentreVu Network Reporting Connection Window displays, prompting you to enter a login and password to the CMS server. Use a valid CentreVu Supervisor login ID. At the input terminal type field, enter cvsup.

When you successfully connect to the CMS server, a message on the CentreVu Network Reporting Connection window indicates the Connection to the server is up and the window automatically minimizes on your desktop. The Connected Servers field on the Connect to CMS Server window indicates each of the CMS Servers CentreVu Network Reporting is currently connected to.

Repeat steps 1–5 for each additional CMS Server you wish to connect to.

9. Once the Connected Servers field on the Connect to CMS Server Window indicates each of the desired CMS Servers you are connected to, select the View Report button.

Result:

The Connect to CMS Server window automatically closes and the Data Reporter window displays with the selected data items displayed in the VDN report.

Opening a saved report initially

1. Start CentreVu Network Reporting.
2. If report layout files have been saved, then the Select a Report Layout window displays.
no reports layout files have been saved, the **Connect to CMS Server** window displays.

3. If the **Select a Report Layout** window opened, select the saved report you wish to view.

4. Select OK.

   **Result:**

   The CentreVu Network Reporting Connection window displays, prompting you to enter a valid CentreVu Supervisor login and password to each required CMS server. At the input terminal type field, enter cvsup.

   Once you successfully connect to each of the required CMS Servers, the selected report will be displayed.

---

**Opening a saved report while viewing a report**

1. Select File from the Report menu.

2. Select Load Report.

   **Result:**

   The Select a Report Layout window displays.

3. Select the report you wish to view.

4. Select OK.

   **Result:**

   The selected report displays.

   If you are not logged into the CMS server for the selected report, you will be prompted to login to that CMS server.
Generating a Drill-Down Graphical Report in CentreVu Network Reporting

Overview

This information describes how to generate a graphical Drill-Down report for a selected data item from a real-time or historical VDN report. For more information on the Drill-Down report see Using the Drill-Down Feature information.

Generating a Drill-Down Report

From the VDN Report do the following:

1. Double-click the desired data column within the report.
   
   It is possible to drill-down on only one data item at a time.

   Result:

   A drill-down report is displayed in the Data Reporter window.

2. Select the Return to Table button if you would like to return to the tabular report.

Copyright © 2000
Lucent Technologies.
All rights reserved.
Modified: September 5, 2000
Using the Drill-Down Feature

Purpose

Using the Drill-Down Features describes the drill-down report and how to generate them in CentreVu Network Reporting.

Contents

This section includes the following topics:

- [Drill-Down Report Description](#)
- [Generating Drill-Down Reports](#)

Copyright © 2000 Lucent Technologies. All rights reserved.
Modified: September 5, 2000
Drill-Down Report Description

Description

The Drill-Down report is a graphical representation of one data item selected from the Split/Skill or VDN Report. The Drill-Down report graphically displays the current values for a single data item's column as a bar chart and includes summary information for the data items whose summary is an average value. This report does not include the summary information for data items whose summary is a total or greatest value.

Copyright © 2000 Lucent Technologies. All rights reserved. Modified: September 5, 2000
Generating Drill-Down Reports

Overview

The following information describes how to generate a Drill-Down report from a Split/Skill or VDN report. For more information on the Split/Skill or VDN report see Split/Skill Reports or VDN Reports.

Generating a Drill-Down Report

From the Data Reporter do the following:

1. Determine which data column you wish to drill-down on.
   It is possible to drill-down on only one data item at a time.

2. Double-click the desired data column.
   **Result:**
   A graphical drill-down report displays in the Data Reporter window.